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1. Introduction 

WinBAR software is a stand-alone application designed under the Windows environment which is 
dedicated to the raw material management. It integrates fully with WinSTEEL, WinSER, Stock and 
Purchasing modules. 
 
WinBAR  allows the user to create bars nesting before dispatching to workshop machines. This has 
benefits with material purchasing, and brings control from the shop floor to the office. This nesting 
reduces material waste minimizing the number of cuts hence optimizing machine efficiency.   

Purposes  

 Data import from any CAD system 
 Manual Input for length bars and profiles 
 Bars nesting 
 Scraps optimisation 
 Reduce tooling changes 
 Recovery of stock bars 

Description  

 Import of lists from Technical Department 
 Automatic generation of profiles at the import 
 Optimisation of all nesting parameters 
 Works list creation 
 Manual input 
 Different algorithms for optimisation 
 Automatic/Manual nesting 

Location  

 Technical department 
 Production department 
 Workshop 
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1.1 General information 
 
In this chapter, we will give some general conventions used in WinBAR, to facilitate the comprehen-
sion of various operations and the interactive dialogue between operator and computer 
 
In this manual, the decimal point replaces the decimal comma. It is of fundamental importance to 
distinguish between the figure "0" from the capital letter "O"; the figure "1" from the letter "I", that 
could generate errors. 
 
 
1.2 Keyboard 
 
In the manual, dialogue keys with the computer will be : [...] 
The RETURN key, (or ENTER, according to the keyboard) will be symbolised by [ENTER]. 
 
The key ESC will be symbolised by [ESC]. 
 
The function keys (Keyboard tob ) could be symbolized by [Fxx] 
where xx represents  values from 1 to 12. 
For example [F10] means " press the function key F10 " 
 
The function [Alt-A] means "press the ALT key together with the A key". 
 
 
1.3 Moves and Selection in the application 
 
 To select Items into the menu you have to push ALT key. The selection bar opens the first 
menu. The following move can be possible with the help of direction arrows. 
  The use of the mouse allows all moves without using secondary keys such as ALT or CTRL. 
 

Open Save New Delete Details Reports Delete NestingNesting  
 

ALT-F  Open File Menu, 
ALT-D  Open Data Menu, 
ALT-S  Open Exit Menu , 
ALT-U  Open Utilities Menu, 
ALT-C  Open configuration Menu, 
ALT-Q  Close and Quit WinBAR 
ALT- ?  About WinBAR 
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1.4 General Presentation of WinBAR 
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2. Configuration 

Before any nesting can take place, the software needs to be set up and configured. 
 
 

2.1 Application Configuration 
 

 
 
The application needs to be set up to run either as a standalone program, or to use the base set-
tings for WinSTEEL if this is preferred. 
 
The Options menu can be found on the top configuration menu. 

 

 
 

2.1.1 Directory 

 
To set WinBAR to use the WinSTEEL settings, point the Base directory to this shared folder. Please 
note, WinBAR data menu should always be unique to this application, and it is recommended to 
keep as default. The model folder is where the WinBAR reports are. If you are setting WinBAR up as 
a standalone application, please add in the line CAM the directory where CAM files are to be ex-
ported as default. 
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2.1.2 Option 

 

Default Values Gives Default value for material grade and treatment. 

Field  Description 

Material Distinction  Two similar profiles with different material grades will be oper-
ated as two elements. 

Treatment Distinction  Two similar profiles with different treatments will be operated 
as two elements 

Fabrication Group Use the Profile Group Item. 

Counter This shows the nesting number  

 
 

 
 
 
 
The Option menu for Profiles and Gussets can be left unchanged for standard installations.  
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2.2 Imports Configuration 
 
WinBAR accepts all external data to insert them on single information flow. If you are using 
WinSTEEL then this import process is not required 

 
This menu point is used to update the import source. 
For each, it is necessary to specify the following information:  
Name or Description of the import source which will be on the lists. 
Import type (CAM Files, DSTV Files, DXF Files, etc...). 
A necessary Option; for certain configurations. 
 
 

 
 
 

2.2.1 Options 
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2.2.2 Report 

 
 
 

2.2.3 Drilling 
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2.3 Database  Configuration 

 
 
WinBAR has its own Data Base and the data may be the same for several applications if the 
necessary link is enabled in all applications. For example, it is installed along with Win-
STEEL, then all the following will be set up with options that are shared between the two 
modules. 
 

 

 
 
 

2.3.1 Profiles 
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This information on material profiles, their sizes and characteristics is used in various Steel Projects 
applications. The profiles are divided by categories according to their graphic view situated on the 
right of the screen. Fig. 5-2 above. 
To select a profile category click on the corresponding icon, the graphic will change and the parame-
ters can be modified. 

. 

2.3.2  Major Profiles Types 

2.3.2.1 Hot Shapes  

The key-in of the weight and surface which is to be painted by me-
tre. 
The calculation will be done with the width of the secondary posi-
tion. 
Automatic calculation of the weight and the linear surface area.
  

2.3.2.2 Special Profiles 

 Linear weight and surface area must be inserted as for profile 
values. 

2.3.2.3 Asymmetrical Beams (ASB)  

Automatic calculation of the weight and the linear surface area.
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2.3.2.4 Tubes 

Automatic calculation of the weight and the linear surface area.
  

  
Search and Update Profiles 

 
1st case:  
  Select profile type using the corresponding icon 

Insert the first letters of the codes. The program will list          
all profiles starting with chosen letters. 

  
2nd case:  
 

Insert a complete profile code. The program will select 
automatically the profile type with corresponding figures 
and all relating values. 

 

2.3.3 Automatic Profiles 

This allows the user to insert "automatic profiles ". 
By "automatic profile" we mean all profiles whose code gives dimension values. 

 
To allow automatic weight and surface area calculation, this profile can be part of all profiles 
types except hot and special profiles. 

 
For each automatic profile, all codes must contain ? - question mark - at the end. 

 
The input fields proposed by the program must contain increasing values starting by 1. This 
value sequence must also exist inside the automatic profile code separated by the following 
characters: 

    * - star 
    x - x lowercase 
    X - X uppercase 

2.3.3.1  Example: Flats creation 

  Select profile type  FLAT 
  Insert FLAT? Or FLT? Or FL? 
  Insert value 1 into H dimension field, 
  Insert value 2 into A dimension field, 
 

When the program encounters FLAT150*10, its interprets this data as  
   profile type FLAT 
   H value dimension equals 150 
   A value dimension equals 10 
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Modification and additions to the sizes of Standard Flats used by 
the client are handled by activating the Standard Flat icon on the 
above page, Fig 5-4, the following table opens. 
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This screen above determines the selection criteria to be applied when flats are used. Fields 
include rectangular shape, any rotation, metric or imperial and tolerance. It determines if we 
are to nest flats along the narrow side (min) or longest side (max). 

 
To add a standard flat simply tick the corresponding box. To add a new standard flat size to 
the table, simply scroll to the bottom of the page and double click in the left hand box (as 
shown below), type in the width and press enter/return on your keyboard. This will create a 
new field and tick the thickness to suit. 

 

 
 
 
 

In the case of Tipo D machines the degree of bevel cut can be inserted and this is particularly im-
portant when combined with the Total box select. 
 

2.3.4 Total - FLAT and PLATES 

This screen utilises the fields Prefix, Notch Minimum and angle and Total in order to perform a 
screening to determine how to categorise the parts. Even if the component is sized and named as a 
FLAT at importation or drawing, with Total activated (ticked) WinSTEEL will check that all of its cuts, 
punching and coping can be completed in entirety on the Tipo D. If it has any tooling requirement 
outside the limits of the machine the part will be renamed a PLATE and routed to an available plate 
machine, say a Tipo B. 

  

 
 
 

Min Max 



User Manual WinBAR – V5.130   Page 16 of 40 

 

 
Steel Projects, Rue des frères Lumiere 38200 Vienne France           Copyright 2009 Steel Projects  

T. +33 474.31.17.30   F. +33 474.78.04.10   M. support@steel-projects.fr    W. www.steel-projects.co.uk   
 

2.3.5  Asymmetrical Beams (ASB’s) 

 
The single difference between an automatic and semi-automatic 
profile is the possibility exist to set some constant values. This 
may be of use for ASB’s and their profiles family. 

2.3.5.1  Example semi-automatic profile: ASB? 

 
 

 
In this example, all profiles starting with ASB will have the constant dimension values as fol-
lows: 

  Dimension A equals 10 mm, 
  Dimension E equals 15 mm, 
  Dimension E1 equals 12 mm, 
 

All other fields will be like code values with corresponding sequence as follows: 
 
  H= Code Value 1  
  B = Code Value 2 
  C = Code Value 2 
 

NB: When using ASB’s it will only be possible to stand the beams in the vertical position 
for machine processing (clamping is the limitation here) and therefore the only fields to be 
used are H and B as C will not be used to process the part.   

 
2.4 Material Grade 
 
Each material corresponds to a description, and a density. 
The density is used for the calculation of the secondary position weight.   
Material management is not only for steel (ALU, WOOD, etc...). 
Remember that profile linear weight will be calculated with a density of 7.85. 
A material will be inserted by default during the configuration.  
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2.5 Treatment 
 

 
 
 
 

Each treatment corresponds to a code, a description and a price by default according to the 
measurement unit. It is also possible to separate this treatment considering different prices 
by analytical groups.  

 
2.6 Painting 

 
This takes into account the thickness of the finishing layer for the calculation of piece lengths 
and screw positions. 
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2.7 Profile Groups 
 
This section permits the user to regroup one or more profiles within a set to enable the fol-
lowing: 

 
 - calculate material cost for each position, some modules only 
 - assign default tooling to each position of this profile group 

 

2.7.1 General 

 
 

 
 

Group Name of the Profiles group 

Description Description of Profiles group 

Unit Measurement unit used for this Profiles 
group 

Mini/Maxi length Mini/Maxi  piece length to belong to this 
group 

Mini/Maxi weight Mini/Maxi piece weight to belong to this 
group  

 
A piece given can belong to various groups and the user is required to select the sufficient 
criteria to assign without any ambiguity in the profiles group.  

2.7.2 Tooling 

In this section you may define how the tooling available in your workshop could be used to 
define limitations on the analytical groups. 
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2.7.3  Stock 

This page of the profiles group management is where we input the preferred commercial 
stock lengths used for purchasing by the company. These lengths will be used for bar nest-
ing purposes and material purchase reports. 
 

 
 

 

Storage Description of the site of profiles group 
storage 

Increment Elementary stocking length  

Mini scrap Mini stocking length 

Length Purchasing length 

Limit Quantity which will action purchases 

Purchase Minimal quantity of purchase 
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2.7.4 Analytical Group 

Within data profiles group it is possible to further specify Analytical Groups, these named 
groups are chosen by the user to best suit the combination of his own machines and working 
preferences. These groups may contain several different member profiles and may also have 
material size and grade limitations.  
 

 
 
 

When the Profiles button is activated a profiles parameters page is opened, as below. On 
this page the user can select the profiles and sizes that are to be contained within the select-
ed analytical group. These size limitations can be min and max dimensions. In the following 
example this analytical group contains Beam and RSJ profiles up to a maximum of 304mm 
deep. 
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2.8 Tooling 
 
The parameters entered in this table may be used for different factory information (for exam-
ple production time, scheduling, etc ...) depending upon the modules installed. 

 

 
 
 
The tooling cost per hour is used to calculate the global cost for a contract or factory job. The 
tooling quantity per hour is an indicative value to define the necessary time to produce each 
position with corresponding tooling, subject to certain modules being installed. 

 
2.9 Standard Tooling 
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2.10 Tooling Cycles 
 
 
For each defined analytical group we can now begin to format our preferred way of working. 
Chose the analytical group, select the first tooling activity, say cutting and then allocate the 
preferred machine to perform that task. Note that several machines may all perform certain 
activities; the order is top machine first choice. 
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2.10.1 Machines 

In this section we identify all the machines in the workshop and allocate all the relevant tool-
ing process available on those machines. 

 

 
 

 

2.10.2 Tooling 
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2.11 Customers 
 
Customers information stored in the system to be used to generate certain reports (Reports 
for customers, Purchases for suppliers), subject to certain modules. 

 

 
 

 
 

2.12 Suppliers 
Suppliers information stored in the system to be used to generate 
certain reports (Reports for customers, Purchases for suppliers), 
subject to certain modules. 
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3. Nesting Parameters  

 
This section defines all needed parameters for each cutting machine. You can also define default 
parameters if you don't cutting machines. 
 

First Cut  Distance left before the first cut in the beginning of 
the bar 

End Bar Scrap Distance left for the first cut in the beginning of the 
bar 

Saw thickness  Thickness of the blade or the band saw. 

Distance cut Not  Distance left between two non parallel cuts 

Tolerance  Distance must be taken in consideration for the 
length of the bar. 

Maxi Gauge Lines Number For each profile side, the greatest number of the 
gauge lines. 

Maxi diameters Number For each profile side, the greatest number of different 
diameters. 

Nb Of Components Maximum number of different components included in 
the same bar. 

Scrap 
 

Determine if the bar scrap should be at the front or 
the back of the bar 

Cutting Check The angles the machine can cut bevels 

Optimisation Leave as not any to not rotate parts, Optimise cutting 
to enable rotation of parts.  

Flange Tick to enable nesting of parts with bevel cuts in the 
flange 

Plat Tick to enable punching of notches in flat bar 
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4. Import of Parts 

Once the software has been configured, the first stage is to import or create the parts that you want 
to optimise. If you have WinSTEEL module, you will not need to do this step as the parts will be im-
ported automatically. 

 
 
4.1 Import Configuration 
 
To Set up an import, go to the configuration – import menu. 
 

 
 
 
This menu is used to update the import source. 
For each, it is necessary to specify the following information:  
 

Name or Description of the import source which will be on the lists. 
Import type (CAM Files, DSTV Files, DXF Files, etc...). 
A necessary Option; for certain configurations. 
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4.2 Import 

 
Click on the Import icon (see above Fig 1) this will launch the Import screen below  

 

 
Select the file Import type that matches the NC file type you wish to Import and press OK. 
 
The following screen appears. Press the Browse button to browse to your contract and select, the 
relevant NC files for the contract/load will appear on the right-hand screen.  
 
All NC files on the right of the screen will be automatically imported into WinSTEEL when you select 
Ok. If you don’t wish to import certain NC files then move them to the left screen by double clicking 
on them or select them and press arrows left. 
 

 
 
The following screen appears with the parts created, simply press the OK button and the contract 
will now be inside WinSTEEL. 
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4.3 Manual Creation Of Parts 
 
Sometimes it may be necessary to ad parts to nest with no nc data. To do this we can add them 
manually on the Parts Tab. 
 

 
 
 
On the Parts tab, click on the top menu button “new. This will bring up the option box as per the 
screenshot below. 
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Add the part information for all of the available boxes. If the part has a bevel, click on the bevel icon 
to add to the part. Once all relevant data has been added, press OK, and then repeat for each of the 
parts. 
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5. Optimisation 

 
From the main screen of WinBAR, when you have imported the parts from WinSTEEL / CAD sys-
tem, you are able to see all the parts to be nested on the Parts tab. To perform a nesting you simply 
click on the bar nesting icon as shown in Fig 12 below. 
 

 
 
 
To nest the parts into Commercial lengths simply click on the Bar Nesting icon shown above (the top 
row of icons).  
 
The WinBAR software interrogates the parts (shown on screen when the Parts tab is selected) for 
comparable section size, material grade and tooling requirements (i.e. any drilling). 
 
The comparable parts are then nested into your pre-specified commercial lengths for that section 
(Fabrication/Analytical Group) and at the same time they are routed to your machine of choice for 
fabrication (Machine above). 
 
 
 
 
 
 
 
 
 
5.1 Adding None Standard Stock Sizes 
If you know that you hold stock of bars (including offcuts) that are not commercial lengths for any of 
the profiles in your selection, you can make sure the nester takes these into consideration by manu-
ally adding them in the stock tab.  Before doing the nest into commercial lengths. 
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 Fig 13 
 
In the stock tab, double click anywhere on the main screen and an ADD box will open. In the drop 
down list next to PROFILE, it will give you a choice of the particular profiles that appear in the selec-
tion. Simply choose the relevant profile, then enter the grade, length and quantity information then 
press OK. This will add the bar to the stock list. Repeat this for all the sizes that are not commercial 
lengths.  
 
Now when you do a nesting as before, the bars you added into the stock list will be used as priority, 
for any profile this list does not cover, commercial lengths will be used. 
 
 
 
 
 
 
 
 
 
 
5.2 Nesting Options 
The following screen appears. Select either standard type 1 (a quick nesting) or 2 (for a more thor-
ough nesting) and then click on the Purchase/Stock Tab. 
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Fig 13 
 
On this page, Fig 14, you are able to choose to nest into either Commercial Lengths or Value by de-
fault. For the bulk of the work use commercial length, if however you have certain lengths known to 
be in stock for certain items you can select Value by default. Select the Value by default circular but-
ton and then enter the lengths to be used in the Value by default fields to the right. 
 

 
 

Fig 14 
 
Press the Bars Nesting button and the parts will be nested into the selection you have made. 
Once you proceed with the bar nesting the following screen appears with the Bars Tab.  
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This screen provides you instant information on the bars required and the amount of scrap (waste) 
or off cuts together with a visual of the actual parts inside the bar. 
 

 
Fig 15 

 
From the screen it is now possible to see the length and % of scrap. 
 
Bars with excessive Scrap (waste) can be un-nested and then re-nested into stock off-cuts or or-
dered cut to length. See below for further information on how to un-nest a bar and re-nest cut to 
length. 
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5.3 Bars with excessive Scrap (waste) 
To un-nest a bar with excessive Scrap (waste) in the main WinBAR page on the Bars Tab, simply 
select to highlight the bar then right click on it then from the pop up screen select Delete. Then from 
the confirmation pop up screen select Yes. 

 
Fig 16 

 
This converts the bar into parts and puts the parts back into the Parts Tab where they can be re-
nested to suit the available material, this could be off-cut lengths or they could be ordered cut to 
length. To order cut to length. Simply select to highlight the parts and click on the cut to length icon 
shown below. The highlighted parts will now be converted to bars of their true length. 

 
 

Fig 17 
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If you require to nest these parts into stock off-cuts then select the bar nesting icon to launch the bar 
nesting screen, as below and select the Stock/Purchase tab. Then select Value by default, this un-
selects commercial length and you are able to input the length to be used for nesting these parts. In 
the example it will be bars 7800 long. 
 

 
Fig 18 

 
Press the Bars Nesting button for the nesting to take place. This new bar is placed alongside the 
already nested commercial lengths. 

 

5.4 Manual editing of bars 
 

WinBAR has the ability to alter the bars that have been nested by the optimizer.  
 
Once you have done a nesting, you can click on a bar and see the details of the parts that are nest-
ed inside of it. 
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The menu at the top of this screen allows you to make changes to the bar such as rotation, deletion 
or adding an un-nested part from the parts list.  
 

 
 
 
To make more detailed changes to the bar use can also use the modify bar option on the top menu 
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6. Creating reports 

 
Once the nesting is complete, certain reports can be produced to aid with purchasing, and also the 
operation of the machines.  
 

 
6.1 Bars Nesting Results Report 
 
Once you are happy with your nesting you can create the bar nesting results report. This will give 
the machine operators and people on the cross transfer controls a clear indication of what is to be 
produced on each of the machines.  
 
To produce the report, while still in WinBAR, click the printer icon at the top taskbar as shown in Fig 
17 below. This will open a reports window. You need to make sure the “bars nesting results” is 
green by double clicking it, then press OK to send the report to the printer. If you would just like to 
look at the report without printing it yet, press Preview. 
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The report shows you the cutting sheet number in the top right corner. These numbers are important 
as they are the unique reference numbers that the files will be sent to the machine by. In the exam-
ple in Fig 18, the files will be exported to the machine in a folder called 3, and all the part and bar 
files will be in this folder.  
 
The report also gives the part information coming out of each bar, the length, quantity, scrap etc. It 
also show a visual indicator about the part, i.e, if it has bevel cuts or drilling in it.  
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6.2 Bars List 
 
This report will give you a list of the bars only, which is useful for purchasing decisions.  
 
It can be created from the same menu as the bar nesting results, choosing bars list from the menu 
 
 
 
 
 

 
 
 

7. Export to machines 

 
Once the nesting has been finalised and necessary reports created, WinBAR will send the nested 
bars to the machines as a cam file.  
 
This process is automatic when the program is closed and saved. If used with WinSTEEL, the ex-
port path is as designated by this software. If used as a standalone module, the export path is as 
designated by the configuration option CAM. 
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